
Veeva Commercial Vault 
MedComms 20R3 Deep Dive

November 2020



Felicity Heath
Senior Customer Success Manager, EU

Senior Customer Success Manager, EU
Geoff Peters



3Copyright © Veeva Systems 2020

Self Serve Recording Navigation

• Use the panel on the left to 
navigate between features 
and demonstrations

• Both sections and features 
are labeled for your 
convenience 
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20R3 Key Dates
Dates Event
Oct 20 (PODs VV1-2, VV1-8, VV1-12 only) Pre-release vaults available

Nov 2 (all PODs) Pre-release vaults available

Nov 2-6 Validation package available on VeevaDocs
November 2: System Release Memo
November 3: Compliance Documents
November 6: Executed OQs

Nov 20 Release to all limited release PODs and PODs VV1-12, VV1-1065, VV1-1069, VV1-1088
Vault File Manager does not release at this time, and instead releases with the general release PODs

Nov 11 20R3 MedComms Q&A Session
https://veeva.zoom.us/webinar/register/WN_EXzZRh1cRVOHstp6ZlvHDg

Nov 17 20R3 NA PromoMats Q&A Session
https://veeva.zoom.us/webinar/register/WN_0gjt1ZWQT1yfJDpYLZSrGA

Nov 24 20R3 EU PromoMats Q&A Session
https://veeva.zoom.us/webinar/register/WN_rNXUcdxsT468fZVoRFwgZg

Dec 4 Release to all general release PODs

https://veeva.zoom.us/webinar/register/WN_EXzZRh1cRVOHstp6ZlvHDg
https://veeva.zoom.us/webinar/register/WN_0gjt1ZWQT1yfJDpYLZSrGA
https://veeva.zoom.us/webinar/register/WN_rNXUcdxsT468fZVoRFwgZg


Announcements



Register Now

3000+
attendees from 

life sciences

Join our European 
Community

Get Best 
Practices Connect & 

Collaborate

Commercial Excellence

250+
life science 
companies

Hear Latest 
Veeva 

Innovations

17 - 18 November 2020

Medical Commercial Content Data & Intelligence

https://www.cvent.com/events/veeva-commercial-medical-summit-europe/registration-d69c429bab4241a698e923a5fb3ac1ac.aspx?fqp=true
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New Medical Hub on Veeva & U
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Atomic Security for Documents:
21R1 Enablement Change

• Lifecycle User Actions (i.e. change state, start workflow, etc.) on documents will 
automatically migrate to Atomic Security configurations

• Active Workflow Actions (i.e. Cancel Task, Cancel Workflow, Reassign, etc.) on 
documents will be enabled in Atomic Security configurations
− Customers will need to verify Workflow Initiators have a role on a document that permits them to 

perform Active Workflow Actions

• Your Customer Success Manager, Managed Services Consultant, or implementation’s 
Project Manager will help you assess the impact 

20R2 Aug 2020
Support Enabled

21R1 Apr 2021
Auto-On Enabled

Atomic Security for Documents:
Active Workflow Actions

Lifecycle User Actions

will change to 
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Legend

Always refer to the latest Release Notes and Online Documentation for the most up 
to date version of documentation and configuration steps

Configuration Veeva 
Support

Auto-On



Auto On Features



Auto On: Working with Documents
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Changes to Make a Copy for Read-Only Fields
• Overview

− Prior to 20R3 Read Only fields did not retain source document values or populate with default values 
when making a copy of a document. Now:

• If ‘Copy Fields’ is selected, Read Only fields will retain the original document field value
• If ‘Copy Fields’ is not selected, the Read Only field will populate with the default value*

• Considerations
− Fields retain values even if Read Only to user or hidden to the user via Field Dependencies
− If fields are hidden to the user via Security Overrides they will not retain values

20R2.3

Default value populates

Source document 
value retained

Copy fields selected

Copy fields NOT selected

Agency Lead field configured 
to be Read Only and has a 

default value defined

* If one has been configured by the Admin
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Participant Control Help Labels
• Overview

− Workflow initiators for Object and Multi-Document Workflows now see the label Assigned to 
every user or Available to any user on the participant control at the start of the workflow

• Considerations
− The label that is displayed is based on whether tasks in the workflow use the Assign to all users in 

a participant group or Make available to users in the participant group options

20R2.3

Label is dependent on how the 
workflow tasks are assigned
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Undo Acceptance of Tasks
• Overview

− Object and Multi-Document Workflow task recipients can now undo acceptance of an optional task

• Considerations
− This action is only available when a task is assigned to ‘any user’
− When a user clicks ‘Undo acceptance’, the task is returned to the list of Available Tasks and will be 

available to everyone in the recipient list 

20R2.3

‘Task Assigned’ represents 
the task acceptance

‘Releasing’ represents 
undoing the task acceptance
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Improved Rendering Feedback
• Overview

− Vault will now detect the content in documents that is the cause of rendering failures and provide 
users with error messages to troubleshoot issues

20R2.3



Auto On: Vault File Manager
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Vault File Manager: 
Auto-Refresh When Checking In

• Overview
− When a user uses the Check In from Vault File Manager feature, found in the document action menu, 

Vault will now auto-refresh to the latest version

• Considerations
− Prior to 20R3 users had to manually refresh the document viewer to see the latest version 
− If the user closes the pop-up, the document page will not auto-refresh

20R2.3

If the user closes this 
pop-up, the document 
will not auto-refresh
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Vault File Manager: 
Auto-Refresh When Checking In

20R2.3



Auto-On: Reporting
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Reporting: Combine Dashboards Prompts
• Overview

− Dashboard prompts that reference the same Object and use the same Operator will only need to 
be selected once

20R2.2

Same object and operator used 
in two reports

Same object and operator used 
in two reports
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Reporting: Combine Dashboards Prompts



Demo
Reporting Demo: Part 1

20R2.2
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Reporting: Support Is Latest Version in Matched 
Document & Relationship Reports

• Overview
− Matched Document and Document Relationship Reports now support the ‘Is Latest Version’ field

• Use Case
− This field is often used to understand whether a document has been superseded

• Where to Find
− Reports > [Create or Edit Matched Document or Document Relationship Report] > Edit Columns  

20R2.2
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Reporting: Support Is Latest Version in Matched 
Document & Relationship Reports

Reference is no longer latest 
version
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Reporting: Object Formula Fields in Reports
• Overview

− This feature allows users to define formula fields directly in their object reports if they have the 
ability to create and edit reports

20R2.3
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Reporting: Object Formula Fields in Reports
• Overview Continued

− Examples:
• Calculating the difference between or comparing dates

• capa_action__qdm.date_closed__qdm - capa_action__qdm.created_date__v
• Today(“user”) >= capa_action__qdm.due_date__qdm

• Simulating a contains operator
• Find(“123”, capa_action__qdm.risk_analysis__c) > 0

• Reformatting and changing data types
• Round(lots_of_decimals__c, 2)
• Left(complete__v, length(complete__v) - 1))
• Text(date__c, “MM/DD/YY”)

• Considerations
− Only supported for object reports initially
− Multi-pass report types, matrix reports, and EDL Item report are not supported
− Conditional fields are not supported

20R2.3
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Reporting: Early Timeout Detection for Reports
• Overview

− This feature allows Vault to predict if a single entity report will time out 
− If Vault determines that a report will time out, the system displays an error message advising the 

user to add filters or schedule a flash report

• Considerations
− Reports are set to time out after 30 minutes

20R2.3
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Decrease Maximum Size for Flash Report Emails
• Overview

− This enhancement reduces the default maximum email size from 9 MB to 3 MB for flash reports 
in order to avoid potential email distribution issues

− The Flash Report will indicate that part of the report is not included
− The complete flash report can be viewed by clicking the report link in the email 

20R2.4



Demo
Reporting Demo: Part 2

20R2.2



Configuration: Medical Inquiry 
Changes
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• Overview
− Emails are now displayed as they appear to the recipient
− Can still see the HTML source if required

• Considerations
− This feature is enabled with an API call – contact you Managed Services Team to deliver this 

change
− Note the response package link in the email will not take you to the response package by design

• Disabled to ensure Security is preserved
• Click on the response package link below the email

Case Response Email Body Rendering
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Case Response Email Body Rendering

Click here to view the 
response package

Toggle switches allow you to 
view the HTML if required
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• Overview
− Enhancements have been made to MedComms Medical Inquiry Case Response Email 

functionality: 
• Define one or more centralized email addresses that can be set as the Reply To field

• Use Case
− Means you can create dedicated centralized email inboxes for each country

• Considerations
− Admin > Settings > Application Settings > Medical Inquiry Section > Enable “Reply To” with Email 

Responses

Enhancements to Medical Inquiry Case Response 
Email Capabilities
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Enhancements to Medical Inquiry Case Response 
Email Capabilities

Specify Reply To Centralized 
Address



Demo
Medical Information Updates: Part 1

20R2.2
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• Overview
− Add CC and BCC recipients

• Use Case
− Often Medical Inquiries are raised to MSL’s by Healthcare Professionals
− Med Info Team handles responses & needs to copy MSL on the response
− Doctors often request that Assistants are copied on responses to Inquiries

• Considerations
− You need to be using the ”Enable Email Tracking” feature to use this

• Configuration
− More information can be found here
− Contact your Managed Services representatives for help in setting this up

Enhancements to Medical Inquiry Case Response 
Email Capabilities

http://vaulthelp.vod309.com/wordpress/applications/medcomms-application/working-with-medical-inquiry/
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Enhancements to Medical Inquiry Case Response 
Email Capabilities

BCC and CC email recipients
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• Overview
− Administrators can remove the Vault header and footer from all emails

• Use Case
− Customers prefer to use their own header and footer
− Remove the general Vault header and footer

• Considerations
− Admin > Settings > Application Settings > Do Not Include Vault Email Header & Footer checkbox

Enhancements to Medical Inquiry Case Response 
Email Capabilities
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• Overview
− Enhanced cover letter options enable a 

response to a specific Case Request where you 
have multiple requests

• Use Case
− You want to reply to one case request where 

many are present on a Case

• Consideration
− Additional document type has been created to 

support this which includes additional fields you 
can merge in Cover Letter

• Configuration
− For more information speak to your Managed 

Services contact or CSM

Enhancements to Medical Inquiry Case Response 



Demo
Medical Information Updates: Part 2

20R2.2



Configuration: Portals
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Portals: Related Portals
• Overview

− This feature allows Portal Admins to associate multiple Portals, allowing users to filter and search 
results from the current and any related Portals

• Considerations
− The Related Portals widget will be inactive by default; it must be made active by a Portal Admin
− The Related Portals relationship is not reciprocal 
− Content from related Portals is marked as ‘*Related Portal Content’
− You can add up to 12 Related Portals

20R2.3
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Portals: Related Portals
• Configuration

− [Portal] > Edit Portal > Make Active > Save > Related Portals > Add Portal

20R2.3



Configuration: Object & 
Multi-Document Workflows



46Copyright © Veeva Systems 2020

Ad Hoc Task Instructions
• Overview

− Ad hoc task instructions are now supported for Object and Multi-Document Workflow emails 
and notifications

• Considerations
− Ad hoc task instructions can be configured to be optional or required
− Task instructions are entered by the workflow initiator in the workflow start dialog
− The workflow initiator can provide a different set of instructions to each participant group
− The Ad hoc task instructions ‘${taskInstructionsByInitiator}’ token must be added to the 

appropriate templates

Task instructions can be 
required or optional

20R2.2
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Ad Hoc Task Instructions
• Use Case

− Workflow initiators can provide additional instructions to each user group

• Configuration
− Start Step: Admin > Configuration > [Object Workflows or Multi-Document Workflows] > 

[Workflow] > Start > Edit > Add Control
− Object Message: Admin > Configuration > Object Messages > [Object Message] > Edit

To make Task 
Instructions mandatory 

check “Required”

20R2.2
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Default Users from Sharing Settings
• Overview

− Admins can now configure Object and Multi-Document Workflows to auto-populate users and 
groups at the workflow start step based on their roles

• For example, if the Reviewer and Owner roles are allowed to participate in the Review Task, users assigned 
those roles in the Sharing Settings will be auto-populated at the start step

• Considerations
− Workflow initiators can manually remove users if necessary

20R2.3

Reviewers are auto-populated 
based on Sharing Settings and 
Workflow Participant Control

Workflow Participant Control
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Default Users from Sharing Settings
• Configuration

− Admin > Configuration > [Object Workflows or Multi-Document Workflows] > [Workflow] > 
[Workflow Start Step] > Edit > Default users from sharing settings

20R2.3

Object Workflow

MDW Workflow
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Update Sharing Settings in Task Step
• Overview

− Users can now be automatically added to or removed from Object or Document task roles 
sharing settings based on task events (task assignment, cancellation, or completion)

• Considerations
− Multiple roles can be added to a single task step and multiple roles can be added to a single rule
− The role must exist on the relevant Lifecycle
− If the workflow is cancelled the sharing settings do not revert 

Before Task Assignment

After Task Assignment

Selected users have been 
added to the Reviewer Role

20R2.2

Workflow initiator 
selects Reviewers 
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Update Sharing Settings in Task Step
• Configuration

− Admin > Configuration > [Object Workflows or Multi-Document Workflows] > [Workflow] > 
[Workflow Task] > Edit > [Update Sharing Settings or Update Document Sharing Settings]

Multi-Document Workflow Object Workflow

Click to add a rule

Multiple roles can be 
added to a single rule

Click to remove a rule

20R2.2
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Atomic Security for Active Workflow Actions
• Overview 

− Active workflow actions in object workflows can 
now be secured based on lifecycle state and role

− The securable actions are 
• Cancel Workflow
• Cancel Task
• Reassign
• Add Participants 
• Update Task Due Date

• Considerations
− Workflow initiators will have access to these 

actions regardless of permission sets and 
Atomic Security

Example: Approver role 
actions while ‘In Approval’

Owner role actions while 
‘In Approval’

20R2.2
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Atomic Security for Active Workflow Actions
• Configuration 

− Admin > Configuration > Object Lifecycles > [State] > Atomic Security: Actions > Edit > + Rule Override

Behavior Options: 
Execute: Allows users to see and click on the action
Hide: The action is never visible to users

20R2.2
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Additional Task & Workflow Initiator Tokens
• Overview 

− Message Templates for Object and Multi-Document Workflows
now support additional Workflow Initiators and Task tokens

• ${objectType}: Object Type
• ${recipientName}: Task Recipient Name
• ${taskComments}: Task Comments
• ${taskDueDate}: Task Due Date
• ${taskHome}: Link to the My Tasks page
• ${taskInstructionsByInitiator}: Instructions provided by the

workflow owner
• ${taskName}: Task Name
• ${taskVerdicts}: Task Verdicts
• ${workflowInitiatorEmail}: Workflow Owner Email Name
• ${workflowInitiatorFirstName}: Workflow Owner First Name
• ${workflowInitiatorLastName}: Workflow Owner Last Name
• ${workflowInitiatorMobilePhone}: Workflow Owner Mobile Phone
• ${workflowInitiatorName}: Workflow Owner Name
• ${workflowInitiatorOfficePhone}: Workflow Owner Office Phone
• ${workflowInitiatorTitle}: Workflow Owner Title 

20R2.2

Previous task verdicts

Link to the My 
Tasks page

Workflow Owner email

Task comments
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Additional Task & Workflow Initiator Tokens
• Configuration 

− Admin > Configuration > Object Messages > [Message]
− Admin > Configuration > [Object Workflow] > [Notification Step] or [Task Step]
− Admin > Configuration > [Multi-Document Workflow] > [Notification Step] or [Task Step]

20R2.2

To include verdicts from previous 
tasks check this box and select 

tasks to include and add the 
token to the relevant notification

Notification Step Task Step



Objects
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Filter by All Dates in Object Record Audit Trail
• Overview

− This enhancement adds the ’all’ option back to the Timestamp filter in individual object record 
audit trails, allowing user to more easily view and export complete audit trails

20R2.4
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Section Level Help
• Overview 

− Admins can now define help content for 
Object Record Detail Page Sections

• Considerations
− When users view the Object Record Page, 

they can see this information by clicking 
the ? icon on the section heading

• Configuration
− Admin > Objects > [Object] > Page Layouts > 

New Product Detail Page Layout > [Add 
Section or     Section] > Section Help

Enter Section Help content 
and click ‘Save’

Users can access Help 
content by clicking the ?

Edit Section

Add new Section

20R2.2



Demo
Section Level Help

20R2.2
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Audit Action Security for Objects
• Overview

− Previously the object record audit trails were either all visible or all hidden based on the 
application permission shared with documents that applied to all objects

− This feature allows admins to control access to the object audit trail by object, state and role via 
the Object Lifecycle Atomic Security actions

• Considerations
− This feature requires enablement within the object configuration detail options
− This feature does not apply to documents

20R2.3
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Audit Action Security for Objects
• Configuration

− Admin > Configuration > Objects > {Object} > Details Tab > Edit Object > Options > Action Security

20R2.3
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Default by Object Type
• Overview

− Admins are now able to define field default values at the Object Type level
− This feature also allows you to override the Field Default values defined at the base object level

• Considerations
− Default overrides can be defined for all field types where default values are allowed

Base Object level field 
value default

Object Type level field 
override default

20R2.4
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Default by Object Type
• Configuration

− Admin > Configuration > Objects > {Object} > Object Types > {Object Type Field} > Edit

Picklist default values should be returned 
as: Picklist.field__c.Picklist value name

Ex. Picklist.urgency__c.high__c

20R2.4



Admin
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Flexible Job Scheduling
• Overview 

− Job scheduling options have been expanded to allow 
Admins to schedule jobs to run on an hourly, daily, 
weekly, or monthly basis

• Availability
− This feature will be available to Admins automatically 

when creating or updating Job Definitions
• Admin > Operations > Job Definitions

• Learn more about configuring Job Definitions
Previously, Admins could only 

schedule jobs to run daily

20R2.2

http://vaulthelp2.vod309.com/wordpress/admin-user-help/configuring-job-definitions/
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Support Upsert with Object Types
• Overview

− Vault loader now ignores values in the Object Type field during upsert and no longer errors 
when the same object type is specified for an existing record

• Previously this action would fail because the object type field is a read-only on a record after creation

• Considerations
− New header added to toggle this behavior

• NeverIgnore (Default pre-20R3): Must have edit permission on all fields
• IgnoreSetOnCreateOnly (Default 20R3+): Ignore "set on create only" fields whose value has not changed
• AlwaysIgnore: Ignore all fields whose value has not changed

20R2.3
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Managing Sandbox Allowances
• Overview 

− This feature enables Vault Admins to:
• Grant and revoke allowances to Sandboxes
• View all Sandboxes in their Production tree, both 

direct and indirect clones, in one place

• Considerations
− The Set Allowance action is available via UI 

and REST API to manage allowances
− Limit: 4 level deep trees
− Can manage direct children only
− Temporary allowance management also available
− General Release: Only sees direct children
− Limited Release: Sees everything below 
− Pre-Release allowances are not transferable

• Required Permission
− The Sandbox – Edit permission must be granted to the relevant permission set
− Admin > Users & Groups > Permission Sets > [Permission Set] > Admin > Sandbox - Edit

20R2.2
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Vault Loader: 
Bulk Remove Users from Document Roles

• Overview 
− Vault Loader will now support the bulk removal of users and groups from document roles

• Considerations
− You need to know the user and group IDs
− Loader ignores role names that are not available on specific documents

20R2.2
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Vault Loader: Document Metadata Extract to 
handle more than 10 Object References

• Overview 
− Enhanced Vault Loader to support the extract of all document metadata and object columns in a 

single call even when there are more than 10 object references.
− The enhancement has been made to Vault Loader UI, CLI, and REST API

• Considerations
− VQL has a limit of 10 maximum object references allowed

• Customers would have to perform multiple extracts and combine the data manually

Before

After

20R2.2
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Configurable Landing Tabs
• Overview

− This feature allows Admins to configure which tab a user navigates to when they log in to Vault
• For example, users can be directed to the Library upon logging in, rather than the Tasks (Home) tab 

• Considerations
− This feature also adds the new Landing Tab field to the User Object to support configuration
− If using My Vaults, click on the Vault name to be directed to the configured landing page

20R2.3

If using My Vaults, click on the 
Vault name to be directed to 
the configured landing page
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Configurable Landing Tabs
• Configuration

− To add Landing Tab field: Admin > Configuration > Objects > {User Object} > Page Layout > 
{Layout) > Add Landing Tab field to layout section

− To update Landing Tab: Admin > Users and Groups > Vault Users > (User) > Landing Tab

20R2.3

Add Landing 
Tab field

Update default 
Landing Tab
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Generate Outbound Package from Vault Compare
• Overview

− This feature enhances the Vault Comparison report with an option to generate Outbound Packages 
based on the differences found in the Vault comparison, if components are missing or different, 
they will get added to the outbound packages

• Considerations
− Each Outbound package can contain a max of 200 components

• Learn more about Generating Outbound Packages from Vault Compare

20R2.3

http://vaulthelp2.vod309.com/wordpress/admin-user-help/admin-vault-loader/using-vault-compare/


Appendix
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User Permission Sets
• Overview

− When the Allow User-level Assignment feature is enabled the User detail page displays a 
new Permission Sets section allowing the Admin to assign permission sets at the individual 
user record level

• Considerations
− Vault applies the permission sets assigned at the user level and profile level at run time, 

when the user is logged in
− Requires Support enablement and product manager approval

One or more permission sets 
can be assigned from the User 

record detail page

20R2.3
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User Permission Sets
• Configuration

− Admin > User & Groups > Permission Sets > {Permission Set} > Edit

20R2.3
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Truncated Search Result Warning
• Overview

− This enhancement provides users with a UI banner notification when they perform a full-text 
search that hits the 5,000 results limit of relevant matches

− The banner will inform the user that some of the results have been omitted
− The user can see a complete set of results by applying additional filters to the full-text search

20R2.4
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Domain User UI Enhancement
• Overview

− With this release, the Vault Memberships section on the Domain User record detail page lists only 
Vaults for which a domain user has an active or inactive Vault membership

20R2.4

Before

After
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Platform Data Model Changes
• Added the following components to support Landing Tabs:

− Added the Tab Group (tab_group__sys) object, which contains records of all tabs that can be 
selected for a Landing Tab

− Added a new User Landing Tab (landing_tab__sys) field to the User (user__sys) object

• Added the following components to support Integration Query Object Rules:
− The Integration Rules component is extended with subcomponent Query Object Rules, 

including fields:
• Active (active)
• Label (label)
• Filter (filter_clause)
• Object (query_object)
• Primary Object (Yes/No) (primary_object)
• Relationship (relationship)

• Added the following component to support User Permission Sets (support-only 
feature enablement):
− Added the User Permission Set (user_permission_set__sys) object. This object is used to 

provision user permission set assignments

20R2.3
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Platform Data Model Changes
• Added components to support Checklist Question Guidance Text:

− Added the Question Help Text (question_help_text__v) field to the following objects:
• Question Design (question_design__sys)
• Response (response__sys)
• Library Question (library_question__sys)

• Added components to support Checklist Enhancement: Decimal Response:
− Added the Decimal Places (decimal_places__sys) field to the following objects for the Number 

Question object type (number_question__sys):
• Question Design (question_design__sys)
• Response (response__sys)
• Library Question (library_question__sys)

• Added the following components to support Application Performance Statistics:
− A new standard object Performance Stats-Application (app_perfstats__sys) has been added to all 

vaults. This object captures additional performance statistics specific to your application
− As of 20R2.3, this object exists to support this future functionality and does not yet track any statistics

20R2.3
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Platform Data Model Changes
• Added the following values to the 

Language (language__v) picklist:
− Chechen
− Chuvash
− Corsican 
− Herero 
− Kalaallisut-Greenlandic 
− Kirghiz-Kyrgyz
− Mandarin 
− Romansh 
− Samoan 
− Turkmen

• Updated the Link (link__sys) field on 
Checklist related objects to enforce 
uniqueness and help with migration: 
− Checklist Design (checklist_design__sys)
− Section Design (section_design__sys)
− Question Design (question_design__sys)
− Available Answer Design 

(available_answer_design__sys)
− Dependency Design 

(dependency_design__sys)
− Checklist Design Master 

(checklist_design_master__sys)
− Sub-Checklist Design 

(subchecklist_design__sys)

20R2.4
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Commercial Data Model Changes
• Overview

− In this release, we’ve added the following components to the Commercial data model to support 
new features:

• Added new object Embedded Metadata (embedded_metadata__sys)
• Added new document field Approved Links (annotations_approved__v)
• Updated the following fields to be non-mandatory on all documents: 

• Content Creation Cost (content_creation_cost__v) 
• Content Creation Currency (content_creation_currency__v) 
• Global Content Type (global_content_type__v)

• Added new Related Portals Portal Widget object type
• Added new Related Portals Portal Widget Content object type
• Added a label for the description/about section to the Portal object
• Added new Create From Annotation ID (create_from_annotation_id__sys) field on the Link 

Target and Claim objects
• Added new Create From Annotation Source (create_from_annotation_source__sys) field on the Claim object

20R2.3
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Commercial Data Model Changes
• Considerations

− Please note that some of these data model changes are relevant to your MedComms Vault too –
such as the related portals changes. 

− Features related specifically to PromoMats only are not relevant to MedComms Vaults, these 
include those changes for Standard Metrics and Auto Claims Linking. 

− Click on the links for more information. Links are available on the downloadable slides – see the 
penultimate slide called Resources. 
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MedComms Data Model Changes
• Following changes have been made to the MedComms Data Model

− Added new join object Case Response Recipient Join (case_response_recipient_join__v) with the 
following fields:

• Case Response (Parent Object)
• Person (Parent Object)
• User (Parent Object)
• Recipient Type (recipient_type__v)

− Case_response_recipient_join__v object has the following object types:
• Associated Contact (associated_contact__v)
• Colleague (colleague__v)
• Case Contact (case_contact__v)
• User (user__v)

− Added new picklist Recipient Type (recipient_type__v) with values CC (cc__v) and BCC (bcc__v)
− Added the following new fields on the Case Response Emails object:

• Reply To (reply_to__v)
• CC Recipients (cc_recipients__v)
• BCC Recipients (bcc_recipients__v)
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MedComms Data Model Changes
• Continued …

− Added the following new object types on the Person object:
• Associated Contact (associated_contact__v)
• Colleague (colleague__v)
• Centralized Email Address (centralized_email_address__v)

− Added new field Primary Case Contact (primary_case_contact__v) on the Person object*
− Added the following new fields on the Case Response object:

• Case Response Recipient Join (case_response_recipient_join__v)
• Reply To (reply_to__v)

* Only for the Associated Contact object type
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Set Latest Version for Vault File Manager
• Overview

− Organizations can now control when the Vault File Manager automatically updates to the latest 
version by adding keys to the user's registry to indicate the highest version that the VFM client 
can update to

• Considerations
− Setting up this option could prevent users from receiving critical bug fixes
− Vault File Manager will not update to a newer version than the one defined in the user's registry, 

even when there are updates available

20R2.3
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High Volume Object
• Overview

− This feature add a new high-volume data store option for Vault objects that is optimized to 
deliver fast write performance for large or frequent transactions

• Considerations
− The high-volume option has a narrower feature set than standard Vault objects and requires 

technical knowledge to configure optimally
• No tokenized search, Lookup, Multi-value picklist, or PII fields

− We recommend thoroughly reviewing the feature documentation and/or working with 
managed services before using this data store option

20R2.3
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High Volume Object
• Configuration

− Admin > Configuration > Objects > Create New Object

20R2.3
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Integration Query Object Rules
• Overview

− Integrations query object rules are used to define rules that restrict the data or documents sent to 
a target vault in HTTP callbacks associated with Spark integrations

− Query object rules are a rule type within Integration Rules where the existing field rule 
SELECT data or documents

− The new query object rule can filter the data further with a WHERE filter clause using Criteria VQL

20R2.3
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Exclude Security Overrides Referencing Auto-Managed 
Groups When Migrating Document Fields

• Overview
− When migrating document fields, Vault does not include security overrides that reference Auto-

Managed Groups in configuration migration packages

20R2.3
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Merge Fields Token Character Length Increase
• Overview

− This total length of a Merge Field token in Microsoft Word DOCX files has been increased to a 
maximum of 1,000 characters to make it easier to use referencing fields in related object records

20R2.3
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Expand Sibling Record State Check Entry Action 
to All Applications

• Overview
− The lifecycle entry action ‘Check Sibling Records’ before updating related record, which validates 

that all the siblings of a record are in the same state or group of states before changing the state of 
a related record, is now available in all Vaults

• Use Case
− This configuration option is ideal for actions where an organization wants the related record to 

change states once all actions are complete

• Configuration
− Admin > Configuration > Object Lifecycles > [Lifecycle that applies to the “sibling” object]

• Click into the lifecycle state that you want all sibling records to be in when you change the related record state
• Add the Check sibling records before updating related record entry action
• Under All sibling records in lifecycle state, select one or more lifecycle states of records that you want to check
• Under Related Object, select the related object that you want to move to a new state. The object must be 

related through an outbound relationship, either Parent or Reference
• Select the Target State for the related object
• Click Save

20R2.2
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Show Current Time in Overlays
• Overview

− In order to provide a more compliant way to track 
documents exported from Vault, Document 
Overlays can now be configured to display the 
current time and time zone by utilizing the new 
${currentTime__v} token

• Considerations
− The token will display the user’s time zone

• Time format can be 12-hr or 24-hr depending on user’s 
locale and Vault format setting

• Use Case
− The full date and time the rendition was 

downloaded from Vault can be capture by utilizing 
the current time token along with the existing 
current date token

${currentDate}, ${currentTime__v}

20R2.2

${currentDate}, ${currentTime__v}
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Show Current Time in Overlays
• Configuration

− Admin > Business Admin > Overlays > [Overlay] > Edit 

• Learn more about managing Overlays

20R2.2

The current time token can 
be used in the header, 
watermark, and footer

http://vaulthelp2.vod309.com/wordpress/admin-user-help/templates/overlays/
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Show Current Time in Overlays



Resources
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Resources
• Contact your Customer Success Manger or Managed Services Consultant
• Email: VaultCustomerSuccess@veeva.com
• 20R3 Release Kit: https://www.veeva.com/products/commercial-vault-release-

presentations/
• Vault Resource Library: https://support.veeva.com/hc/en-us/articles/360013243773-

Veeva-Vault-Educational-Resource-Library
• Veeva & U: https://www.veeva.com/eu/commercial-hub/medical-innovation/
• Vault Help: http://vaulthelp2.vod309.com/wordpress/

mailto:VaultCustomerSuccess@veeva.com
https://www.veeva.com/products/commercial-vault-release-presentations/
https://support.veeva.com/hc/en-us/articles/360013243773-Veeva-Vault-Educational-Resource-Library
https://www.veeva.com/eu/commercial-hub/medical-innovation/
http://vaulthelp2.vod309.com/wordpress/


Thank you
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